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Workplace safety is everyone’s responsibility. 
Both employers and employees must make an active 
contribution to ensuring their workplace is safe. 
Hazards need to be identified and risks assessed to 
reduce the risk of injury in the workplace. If you are 
working at a computer for an extended period of time 
each day, your workstation must be comfortable and 
designed to help you carry out your tasks efficiently. 
You will need to organise your work so that you are 
not doing a repetitive task for a long time. You should 
also take regular breaks to stand up and stretch. 

Another consideration is to use resource 
conservation techniques to prevent wastage. Most 
organisations require staff to follow resource-saving 
procedures such as turning off lights in unused rooms and recycling paper. You need to be 
aware of any conservation efforts made by your organisation.

Workplace safety legislative requirements
You must work in line with legislative requirements, regulations, Australian and 
industry standards, and the relevant codes of practice.
All health and safety legislation requires employers to provide a safe workplace and 
adequate training and supervision, while controlling workplace hazards and risks. 

Health and safety legislation outlines legal requirements such as:

•• managing risks to health and safety
•• promoting and maintaining the health, safety and welfare of people at work
•• protecting people at work from injury and illness, including psychological injury
•• protecting the health and safety of the public in workplaces
•• consulting workers and encouraging them to maintain health and safety
•• providing rehabilitation and maximum recovery for injured workers.

Health and safety policies and procedures
Health and safety policies and procedures are documents that ensure all 
employees work safely and effectively. 
All workplaces in Australia are required to have a health and safety policy in place that 
describes the organisation’s and employees’ responsibility for maintaining health and safety. 
The policy should include the organisation’s goals and objectives regarding health and 
safety, and can help you fulfil your duty of care as an employee.

The following information relates to working in an office and using a computer workstation, 
and should be contained in an organisation’s health and safety procedures.

1A	 Use safe and efficient work practices
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Health and safety procedures outline:

•• workstation ergonomics
•• standard safety precautions and housekeeping
•• safe handling of hazardous substances, e.g. cleaning products or printer inks
•• emergency and fire drills
•• hazard identification and risk control
•• manual handling, e.g. lifting, reaching and repetitive work tasks 
•• emergency contact numbers, including local doctors and hospitals
•• location of first-aid equipment 
•• details of first-aid officers.

Control risks associated with hazardous manual tasks
It is a legal requirement for the PCBU and workers to address the risks 
associated with hazardous manual tasks in the workplace. 
The WHS Regulations and the Code of Practice for Hazardous Manual Tasks outline 
specific requirements for hazardous manual tasks that must be addressed. 

The Hazardous Manual Tasks Code of Practice helps PCBUs and workers to:
•	 identify hazardous manual tasks
•	 assess the risks
•	 control the risks
•	 review the control measures.

A person conducting a business or undertaking (PCBU) must manage risks to health and 
safety associated with undertaking a hazardous manual task, including risks of developing a 
musculoskeletal disorder (MSD).

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own 
set of procedures to manage the risk of MSDs.

To determine which control measures to implement, the PCBU must consider the 
following:

•• postures, movements, forces and vibration relating to the hazardous manual task
•• the duration and frequency of the hazardous manual task
•• work conditions that may affect the hazardous manual task or the worker performing 

it
•• the design of the work area and layout of the workplace
•• the systems of work used
•• the nature, size, weight or number of people or things involved in carrying out the 

hazardous manual task.
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Musculoskeletal disorders
The repetitive movements and sustained body position associated with 
entering data into a computer is regarded as a hazardous manual task and puts 
the operator at risk of developing an MSD. 
MSDs come about in two main ways:
•	 gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through 

repeated or continuous use of the same body parts, including static body positions
•	 sudden damage caused by strenuous activity or unexpected movements, such as when 

loads being handled move or change position suddenly.

MSDs may include conditions such as: 

•• sprains and strains of muscles, ligaments and tendons
•• back injuries, including damage to the muscles, tendons, ligaments, spinal discs, 

nerves, joints and bones
•• joint and bone injuries or degeneration, including injuries to the shoulder, elbow, 

wrist, hip, knee, ankle, hands and feet
•• nerve injuries or compression, e.g. carpal tunnel syndrome
•• muscular and vascular disorders as a result of hand-arm vibration
•• soft tissue hernias
•• chronic pain.

Standard precautions
Your organisation may require you to use standard precautions, particularly 
work practices related to the prevention of repetitive strain injuries (RSIs). 
These include ergonomic practices, workstation design, enforced breaks and regular exercise 
routines, such as stretching, rolling the shoulders and shaking arms.

Workers in an office are expected to follow standard precautions when using a workstation, 
particularly at a sit-down desk. Research on sitting has demonstrated that other precautions 
also need to be considered to help prevent injuries, such using standing workstations and 
alternating the mouse from one side to the other. It is important that you carefully follow 
any standard precautions that are prescribed for your workplace.

Equipment and systems safety checks
An important part of your daily work routine is to check the various systems 
and equipment you use during the day to make sure they are in good working 
order. 
Your organisational policies and procedures should include steps to follow. You may need 
to perform this procedure at the start of your work day or at specified intervals throughout 
the day.
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Practice task 1

Question 1 
Here is a checklist to follow when setting up your workstation. Go through the points that are 
relevant to you and make any necessary adjustments to your work area. You may need another 
person to help you and check your posture. If you are not able to tick some of the checkpoints, 
discuss making alterations to your workstation with your manager.

Chair
�� Is the seat height-adjustable?

�� Is it high enough to allow you to sit comfortably at the keyboard?

�� Is it stable?

�� Does it swivel?

�� Is the height of the backrest adjustable and does it tilt backwards and forwards?

�� If it has arms, can you still get close enough to the desk and swivel the chair?

�� Are your feet flat on the floor or are you using a footrest?

�� Are you sitting up straight with the backrest firm against your back?

Desk

�� Is it large enough to allow the screen and keyboard to be correctly positioned?

�� Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

�� Is it high enough to allow your thighs to fit comfortably underneath?

Keyboard

�� Can it be tilted to allow you to adjust it?

�� Are the symbols on the keys clear and easy to see?

�� Is there sufficient space in front of it to allow you to correctly position your arms?
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6.	 Record required details under the relevant columns (Title, First Name, Last Name, 
etc.) 

7.	 If additional fields are required, such as postcodes, you can rename a column. To 
do this, select Customize Columns, select the field you want to rename and click 
Rename. If entries are not required, highlight them and select Delete. When you have 
the desired fields, click OK.

8.	 To add all the fields required for addressing the letter, place the cursor where you want 
to insert the address block. Details to be recorded in the Address List are as follows:

Title Mr Ms Ms

First Name John Janelle Ha

Last Name Smith Groves Duong

Company Name Green Thumbs Livestock Inc. ARV Financial

Address Line 1 12 Smith St 21 Dorset St 32 Gloster Rd

Suburb Melbourne Sydney Sydney

State VIC NSW NSW

Postcode 3000 2000 2000

9.	 Click OK. Save the database of the list of names as ‘MyList’.

10.	 From the Mailings tab, click the Address Block button. Specify the address block 
elements and click OK. Remove the existing address fields you are replacing.

11.	 To insert a greeting (such as ‘Dear’), select the Greeting Line button. 

12.	 To edit each letter individually, select Finish & Merge, then Edit Individual 
Documents. The letters will open in a new document for you to edit individually. 

13.	 If you are satisfied with the final document, select the Finish & Merge button. Select 
Print documents.

14.	 Go to the File tab, select Save As and save the master letter as ‘MyMerge’.

Labels and envelopes
All organisations need to have a system for entering addresses for 
correspondence to clients or suppliers. 
An organisation may choose to enter addresses directly onto 
envelopes or to print out strips of labels that stick onto the 
envelopes. You can use word-processing software to create labels 
and to print addresses onto envelopes. To add an address to an 
envelope, you are required to use an existing letter.

If you are responsible for large mailouts in an organisation, this 
software function can save you a lot of time.
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Headers and footers
Headers and footers are used to record the same information about a 
document on each page. 
A header appears above the top margin of the 
document, while a footer appears below the bottom 
margin. In some cases, templates may include a 
header that contains the organisation’s letterhead 
with a logo and contact details. 

You may be required to insert a header or footer 
that contains more information, including the 
organisation’s name, date and document title. 
Most of this information is available as predefined 
buttons or fields; alternatively, you may need to type 
in the information required. Most organisations 
have specific guidelines to follow for what is to be 
contained in the header/footer. Apart from the 
company letterhead, in many cases the information in the header/footer is a smaller size 
than the body text, and may have a different font applied. The information that appears in 
headers and footers is repeated throughout a document, or within sections of a document.

To access a header, select the Insert tab and then click on the Header drop-down menu. 
Select a style option from the list. When your header or footer is selected, you will notice 
that the screen options change to the Header & Footer Tools Design tab. This tab contains 
various options to create a header/footer that suits your document, such as a different 
header/footer on odd and even pages.

From here you can either type in the header required, or select the appropriate buttons to 
insert predefined fields into your document (e.g. file name and date). Common options to 
use include Page Number, Date & Time and Quick Parts. 

Once you have finished amending the header, you can double-click on the main document 
to exit the header. It is also possible to access the header/footer by double-clicking on it 
directly.
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Practice task 7

Part A

In the following exercise, you will create a template.

1.	 In Word, select the File tab, select New, then select Blank document.

2.	 Add clipart to the document to represent a corporate logo by going to the Insert tab 
and choosing Online Pictures.

3.	 In the Bing Image Search, type Clipart and the type of picture you’re looking for. 
For example, ‘Clipart Garden Centre’. Select an image and click Insert, then resize 
the image as appropriate. 

4.	 Insert a disclaimer stating that the information contained in the document is for the 
intended recipient only. (If your workplace has a specific disclaimer, insert it here.)

5.	 Save the document as a template titled ‘CompanyDocument’. To save as a template, 
select Word Template from the Save as type drop-down menu.

6.	 Create a footer that provides details of the file reference. To use the template, open a 
new Word document and select Personal, then select the template you saved. This will 
provide you with a blank pro forma of the document, which you can use and save as 
appropriate.

Part B

Question 1 
What can be done to ensure the layout and design of a document meets the professional and 
corporate image of an organisation? 
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Use the view control at the bottom right of the screen to quickly adjust the view of the 
document – simply click on the appropriate option to change the on-screen view.

The differences in the views are as follows.

Print Layout

Allows you to view the document as it will appear when it is printed. 
Page margins and headers/footers are all in view. The break to a 
new page is obvious in this view.

Read Mode

Hides the writing tools and menus and leaves more room for the 
pages themselves. Read Mode automatically fits the page layout to 
your device using columns and larger font sizes, both of which can 
be adjusted.

Web Layout 

Enables you to view the document as you would view a web page. 
Page breaks, page margins, and headers and footers are not 
displayed. Some people have a personal preference for working in 
this view as it focuses on the content itself.

Outline

Allows you to view the document in outline form. This is useful for 
longer documents or reports where styles are used much the same 
as chapter headings. The Outline view allows you to manipulate 
blocks of text. In this view, you are automatically prompted to use a 
new set of tools under the Outlining tab.

Draft

Enables you to work in the document to make necessary 
adjustments to text and content. Page margins and headers and 
footers are not visible.

Zoom options
To make documents easier to read on screen and check the overall layout, there 
are various zoom options available for use. 
You might want to zoom in and increase the size of the document to see text and objects 
more clearly. You might want to zoom out and decrease the size of the document in view to 
analyse the text layout and overall document presentation.
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The zoom control at the bottom right of the screen can be used to quickly adjust the 
zoom view of a page. Simply move the control up or down to change the zoom size of the 
document.

To access zoom options, from the View tab, select the Zoom tool button.

This opens the Zoom dialogue box to enable you to specify the zoom level of the on-screen 
display. You can choose to check the predefined zoom sizes, or you can manipulate it by 
typing in a percentage or by selecting how many pages you want to view.

Other options in the Zoom section are as follows:
•	 100% zooms the document to its normal print size.
•	 One Page adjusts the document so an entire page fits in the on-screen view.
•	 Multiple Pages adjusts the document so multiple pages fit in the on-screen view.
•	 Page Width adjusts the on-screen view so the width of the lines of text matches that of 

the window.
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Learning checkpoint 3 
Finalise documents

Part A
Produce a word-processed document for a workplace. It can be your own workplace, or 
one you are familiar with. The document can be any type of document outlined in Topic 1. 
When producing your document, make sure you:
•	 use the organisation’s style and layout specifications for the type of document you are 

producing – use word-processing functions and formatting options to achieve the 
required result

•	 check the document for spelling and grammatical errors
•	 work within a time line set by your manager
•	 preview and check the document
•	 make any necessary adjustments before printing it
•	 save the document in the correct folder
•	 exit the program.

Part B
Word-process the following text. Make two drafts  of the text using different formatting 
styles and layouts. Each document should have its own consistent style, but the documents 
should be very different from each other. Be as creative as you can with your formatting 
styles and layout. Remember that the main aim of formatting is to make the document easy 
to read. 
•	 Check the documents for spelling and grammatical errors.
•	 Preview and check the documents.
•	 Make any adjustments before printing them.
•	 Save the documents to an appropriate file path and name your documents CallCentre1, 

CallCentre2, CallCentre3.
•	 Exit the program.

Types of call centres

The way a call centre is organised differs from one call centre to another. Some call centres 
divide their services very clearly into sales and customer service, with an operator dealing 
exclusively with either sales or service support. Some large centres have created different 
sections to deal with different aspects of a product, so when a customer calls, the call is sent 
directly to the specialist.

Inbound calls

Some call centres – known as inbound call centres – handle only incoming calls and 
specialise in providing information or service to customers. Customer service calls may 
involve customers calling to ask a question, requesting help with a problem, complaining 
about a product or service, or asking for technical assistance. The kind of call depends on 
the purpose of the call centre.


